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Scope

These release notes present information about the definition, delivery, and operation
of Rational ClearCase LT configuration management software. Any functionality
or characteristics described in this document referring to ClearCase applies to
ClearCase LT as well.
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Product Definition 1

ClearCase LT software for Windows operating systems offers client/server solutions
for configuration management software. ClearCase LT Server software must be
installed on a host in the same network domain as the hosts on which you install
ClearCase LT Client software. A client can access only one ClearCase LT server at a
time. To ensure adequate performance for all ClearCase LT clients, we recommend
that you install ClearCase LT Server on a dedicated host.

Before you install ClearCase LT software, read the Release Notes for Rational Suite
(distributed with your software) as well as the sections ClearCase LT Hardware and
Software Requirements in this document.
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What’s New in
ClearCase LT 2

This chapter summarizes significant new and changed features in Version 2002.05.020
of Rational ClearCase LT.

Summary of Changes in This Release

This version of ClearCase introduces the following new and changed features:

� New UCM Features

� Enhanced ClearCase Web Interface Support

� Enhancements to XML DiffMerge

� Enhancements to ClearCase Explorer

� Enhancement to UCM ClearCase-ClearQuest Integration

� Enhancements to Base ClearCase-ClearQuest Integration

� Enhancements to ClearCase Integrations with Third-Party Products

� Support for Microsoft Active Directories

� Support for Microsoft Windows Terminal Server

� GUI Support for Date and Time Preservation

� Additional Support for Moving VOBS

� New View Database Format

� Changes to Administration Console

� Enhancement to Apply Label Wizard

� Other Enhancements

� Changes to ClearCase Commands

� Changes to Documentation
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New UCM Features

This section describes the main changes to UCM in this version of ClearCase.

Development Stream Hierarchies

In the basic UCM process, the integration stream is the project’s only shared work
area. You may want to create additional shared work areas for developers who work
together on specific parts of the project. Now you can accomplish this by creating a
hierarchy of development streams. For example, you can create a development stream
and designate it as the shared work area for the developers working on a particular
feature. Developers then create their own development streams and views under the
feature-specific development stream. In other words, the developers join the project at
the feature-specific development stream level rather than at the integration stream
level. The developers deliver work to the feature-specific development stream and
rebase their streams to recommended baselines in that development stream.

Interproject and Intraproject Deliver Operations

You can now deliver work from an integration stream or a development stream in
one project to an integration stream or development stream in another project. In
addition, you can deliver work from one development stream to another within a
project. These features make it easier to manage related areas of development within
a project and parallel releases of multiple projects.

Nondefault Deliver Target Policies

The default target for a deliver operation is the source stream’s parent stream. You
can also deliver work to nondefault target streams. Because any stream can now be
the target of a deliver operation, this release adds several policies that you can set on
streams to control what kind of deliver operations the target stream will accept. For
example, you can set a policy to reject deliver operations that contain changes to
components that are not in the target stream’s configuration. You can set these policies
at the project level so that the policy settings apply to all streams within the project, or
you can set the policies on a per-stream basis.

Composite Baselines

A baseline selects one version of every element visible in a component. This release
lets you create composite baselines. A composite baseline is a baseline that selects
baselines from other components. By creating a composite baseline that selects
baselines from every component in your project, you can use one baseline to represent
the entire project.
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After you create a composite baseline to represent the project, the next time you
invoke the make baseline operation on the composite baseline, UCM performs the
operation recursively. If a component that contributes to the composite baseline has
changed since its latest baseline, UCM creates a new baseline in that component.

A composite baseline can select other composite baselines. This feature allows you to
use a composite baseline to represent a system that consists of multiple projects. The
system-level composite baseline can select project-level composite baselines.

Multiple-Component VOBs

You now have greater flexibility in storing components in VOBs. For example, you
can now store multiple components in a VOB. Within a VOB you can make an existing
directory tree into a component. The component’s root directory must be the VOB’s
root directory or one level beneath it. To store multiple components within a VOB,
each component’s root directory must be one level beneath the VOB’s root directory.

Support for Triggers on Additional UCM Operations

This release adds support for triggers to the following UCM commands.
� chbl
� chfolder
� chproject
� chstream
� mkcomp
� mkfolder
� mkproject
� rmbl
� rmcomp
� rmfolder
� rmproject
� rmstream
� setplevel

Other New Features

Other new features in this product release include:

� Ability to deliver selected baselines from a stream.

� Deliver from Stream Preview option. The Deliver from Stream Preview dialog
box now gives you the option to pause the merge to allow you to perform any
merge-related activities. If you select this option, the merge operation stops after it
identifies the versions that require merging, checks out all versions, and performs
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all directory merges. You can then perform any operations related to the merge.
When you are finished, continue the deliver operation.

� The Project Explorer supports changing a modifiable component to read-only if
the component has never been modified in any of the associated project’s streams.

Enhanced ClearCase Web Interface Support

This version of ClearCase provides a number of enhancements to the ClearCase Web
interface.

UCM Support

This version of the ClearCase Web interface supports the UCM developer role. A
developer can use the Web interface to join a project, create new activities, perform
work in those activities, deliver work to an integration stream, and rebase a
development stream to recommended baselines.

Web-Based Diff/Merge Capability

Performing the UCM rebase or deliver operation requires the ability to merge changes
in files. The ClearCase DiffMerge tool has been implemented for this purpose within
the Web interface context. The DiffMerge tool is called automatically when you do a
rebase or deliver operation from within the Web interface; you can also run the Merge
Manager directly from the Web interface toolbar.

Improved Workspace Management for Web Views

ClearCase now provides workspace management capabilities for Web views which
are similar to those for standard ClearCase snapshot view functionality on a local
copy of element versions.

Improved Control Over Session Timeout Length

A new configuration variable has been added to the ccweb.conf file to control the
length of time that elapses before an unattended ClearCase Web session times out.
The new variable is –session_timeout age_in_seconds where the minimum value for
age_in_seconds is 600 (10 minutes) and the default value is 14400 (4 hours).

Interop Text Mode Supported in Web View Creation

It is now possible to specify interop text mode as a characteristic of a ClearCase Web
view during the view creation process.
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Web Server Component Installation Is Now Optional

Installing the ClearCase Web server components is now optional; previously these
components had been installed on all systems.

If you are installing a ClearCase server, the ClearCase Server Options window now
includes a check box for installing Web Server Interface Components; the default is to
install the option. If you are installing a ClearCase client, you must select a Custom
installation to install the Web interface components. First select Custom in the Select
Configuration dialog box; then select the component as desired on the subsequent
Choose Features dialog box. Anew option has been added to the installation.

Changes to Web Interface Documentation

The online help for the ClearCase Web interface has been updated to reflect the
enhanced functionality of this feature. In addition, the chapter Configuring a Web
Server for the ClearCase Interface in the Administrator’s Guide for Rational ClearCase LT
contains updated information on configuring the ClearCase Web server.

Enhancements to XML DiffMerge

XML Diff Merge contains the following new features and enhancements for
comparing and merging XML files:

� Completely new graphical interface, more closely resembling the GUI for the
other ClearCase DiffMerge tools.

� Improved difference computation

� Faster and more efficient

� More powerful ID-matching technology for record-oriented XML data

� More accurate evaluation of differences can merge attribute values from
different contributors automatically

� Compares and merges both XML structure and content, including attribute values

� Supports editing of node values, including text nodes, attribute values, comments,
CDATA sections, and processing instructions; can accept, reject, or change conflict
resolution decisions and/or automatically resolved merges.

� Provides a side-by-side display of all contributors, along with a merge view that
contains only the elements selected by the merge. Expands, collapses, browses,
and filters the data tree resulting from a comparison or merge operation.

� Merges result in well-formed XML output documents.
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� Full support for all ClearCase type manager operations; allows automated or
manual merge (with –query and –qall options)

� XML Browser window lets you view XML documents using CSS or XSL
stylesheets.

� Improved whitespace handling. For example, XML Diff Merge ignores spurious
differences caused by nonterminal whitespace, and enables you to preserve
indents.

� Support for UNICODE characters, as well as ASCII, ISO-8859-1, UTF-8, and
UTF-16 output encodings.

For more information, see the xmldiffmrg reference page and the online help. The
xmldiffmrg reference page is a new addition to the Command Reference at this release,
and the xmldiffmrg online help has been substantially revised to reflect the tool’s
new functionality.

Enhancements to ClearCase Explorer

ClearCase Explorer includes the following new features and enhancements:

� ClearCase Explorer shortcuts enable you to start other tools by clicking an icon in
the Shortcut pane. Site-defined shortcuts can now be configured to be available to
different groups and classes of users.

� The Information pane now dynamically displays content that is tailored to the
user’s current environment, including either online help information about the
current context, or useful information about the item selected in the details list.

� The shortcut menu on ClearCase Explorer supports a command to create a
symbolic link. Right-click in the Details pane of the directory in which you want to
create the symbolic link and click Symlinks > Create Symlinks to access the feature.

� The shortcut menu in the folder pane of the ClearCase Explorer includes a
command to search for files. Right-click in the Folder pane and click Search. This
starts the Windows Find utility, which you can use to specify the attributes of the
search. In the Find: All Files results window, you can use the shortcut menu to
perform ClearCase operations on the selected files.

Online help for ClearCase Explorer has been updated to reflect the new functionality.

Enhancement to UCM ClearCase-ClearQuest Integration

The UCM ClearCase-ClearQuest integration has been enhanced to support
relationships between a single PVOB and multiple ClearQuest user databases.
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In previous versions of the software, all UCM ClearCase projects controlled by a single
PVOB had to point to the same ClearQuest user database. Now different projects can
point to different user databases, even if they are all controlled by a single PVOB.

Enhancements to Base ClearCase-ClearQuest Integration

This release adds a new version of the base ClearCase-ClearQuest integration, which
allows you to associate versions of ClearCase elements with change requests in a
ClearQuest user database.

The integration uses triggers on ClearCase commands to allow developers to associate
versions with change requests. In previous releases, the integration used a Visual
Basic trigger on Windows clients and a Perl trigger on UNIX clients. This release adds
a new Perl library, including a trigger, that runs on Windows and UNIX. The new
integration provides the following benefits:

� Support for UNIX and Windows platforms is now in a common code base.

� The integration is implemented as a set of object classes that provide modularity,
extensibility, and reusability. The integration loads optional classes dynamically
depending on the client environment. For example, if ClearQuest is not installed
on a client, the integration does not load classes that support the ClearQuest Perl
application programming interface (API).

� Performance has been improved by eliminating unnecessary communications
operations.

� Windows clients no longer need Rational ClearQuest installed to access ClearQuest
user databases. Like UNIX clients, Windows clients can now use the ClearQuest
Web Interface to connect to ClearQuest.

� Because the integration supports the ClearQuest Perl API, ClearCase clients on
UNIX can now, like Windows clients, access Oracle user databases on ClearQuest
hosts that run on UNIX. This provides enhanced support for customization by
administrators, because changeable data is isolated from other layers of the
interface.

� The integration supports the association of multiple file imports (by clearfsimport)
with a single change request.

Note: The new integration provides a text-based user interface for developers
who use the cleartool command-line interface and a clearprompt pop-up window
user interface for developers who use one of the ClearCase GUIs such as ClearCase
Explorer (on Windows) or xclearcase (on UNIX). The new integration does not
provide a GUI for developers. For Windows client hosts that have ClearQuest
installed, you may want to use the existing integration that uses a Visual Basic trigger
to provide a GUI for developers.
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Enhancements to ClearCase Integrations with Third-Party
Products

This version of ClearCase includes the following new or improved integrations with
third-party products:

� PowerBuilder Enhancements

� Forte Developer (C++ IDE) Support

� Forte for Java

� VisualStudio.NET (V7) (SCC support)

� Microsoft Word Enhancements

� Borland JBuilder

� IBM Visual Age for Java 3.5.3

Note: In addition to enhancements to specific integrations, all ClearCase
integrations to third —party products that use the SCC API now have support for the
–ptime option. This option preserves the file modify time so that interactions with
ClearCase do not update the file modify time. This option defaults to the site specific
setting, but can be changed through the options menu to give a user default. The
option can also be set for each Add, Check In, or Check Out operation through the
advanced options button

Sybase PowerBuilder Enhancements

The ClearCase PowerBuilder integration has been enhanced to fully automate the
deliver and rebase operations. Users can now perform deliver and rebase operations
on PowerBuilder Library (PBL) objects. They can also re-create PBLs from versioned
objects.

This release add support for PowerBuilder 8.0. The integration has also been
enhanced to make the application path persistent across sessions.

Sun Forte for C++ Support

Forte Developer V6.0 now supports a ClearCase integration. This integration provides
a set of commands and tools that allow a software development team to share, control,
and track files created with Forte Developer.

Using this integration, you can check out, modify, and check in your files without
leaving the Forte Developer IDE or starting another application. You can also use this
integration to access files under version control.
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You can access commands and tools supported by the integration from the Forte
Developer’s Tools menu.

The following ClearCase commands and tools are available:
� Add to Source Control
� Check In
� Check Out
� Compare
� Properties
� Source Control History
� Undo Check Out
� Version Tree
� Help
The above commands and tools give you all the capabilities you generally need.

Forte for Java

This release introduces the integration of ClearCase with Forte for Java version 3.0.

Microsoft VisualStudio.NET (V7) (SCC support)

This version of ClearCase provides an SCC-level integration of ClearCase functionality
with Microsoft’s Visual Studio version 7 (Visual Studio.NET). Support for the
ClearCase toolbar add-in will be available through a ClearCase patch.

Microsoft Word Support

ClearCase Version 2002.05.00 includes an updated integration with Microsoft Word
that uses a COM add-in. Because the COM technology is incompatible with Word 97,
this new integration only works with Word 2000 or Word XP.

However, the old integration is not removed if Word 97 is still installed. If both Word
97 and Word 2000/Word XP are installed, the old integration continues to work with
Word 97, but the new integration is installed for use with Word 2000/Word XP.

Borland JBuilder

This release provides support for an integration of ClearCase and Borland JBuilder 5.0.

IBM Visual Age for Java

This release provides support for the integration of ClearCase LT with Visual Age for
Java 3.5.3. To configure the integration, follow these steps:
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1 Start the Rational ClearCase — IBM Visual Age for Java Integration Configuration
Wizard.

2 Click the Setup button.

3 Specify the install or root path for Visual Age for Java. If you do not know the
path, examine the Windows registry key,

HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Visual Age for Java

Support for Microsoft Active Directories

ClearCase is now fully compatible with Microsoft’s Active Directory and with
Windows NT domains. ClearCase also includes tools that support domain migration
and domain upgrade as described in the Microsoft white paper titled Planning
Migration from Microsoft Windows NT to Microsoft Windows 2000.

For information on converting ClearCase hosts from using Windows NT domains to
using Active Directory domains, read the white paper, ClearCase and Active Directory.
This white paper is available in the “White Papers” section of the Rational ClearCase
Customer Site.

Enhanced Support for Transitive Trusts in Multidomain Active Directory
Configurations

This release has enhanced support for sharing of dynamic views and VOBs across
complex Active Directory configurations.

This support makes it easier for a community of ClearCase users to share dynamic
views and VOBs across multiple Active Directory domains in a single forest. Earlier
ClearCase releases supported this capability, but may have required workarounds to
make dynamic views operate in multiple Active Directory domains in a single forest.
This release no longer requires workarounds such as creating direct trust relationships
or ensuring dynamic views have more liberal read/write access when created.

Support for Microsoft Windows Terminal Server

With this release, ClearCase supports snapshot views with the Microsoft Windows
Terminal Server, Microsoft’s "thin client" server-based technology. Dynamic views,
enabled by the MVFS, are not supported with the Windows Terminal Server.

Note that ClearCase must be installed on the server after Windows Terminal Server
has been installed. If ClearCase was installed previously on the server, you must
remove ClearCase, install Windows Terminal Server, and then reinstall ClearCase.
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In addition, if you are using UCM in ClearCase running on a Windows Terminal
Server, your installation can include only one administrative VOB (PVOB).

GUI Support for Date and Time Preservation

This release provides support for preserving the modification time of a file when
it is added to source control, checked out, or checked in using the ClearCase GUI.
The command-line interface, through the cleartool checkout, checkin, and mkelem
subcommands, already provided this functionality with the –ptime option.

Additional Support for Moving VOBS

ClearCase now supports the following:

� Moving a VOB to another Windows domain

� Moving a VOB from Windows to UNIX

� Moving a VOB from UNIX to Windows

The vob_sidwalk and vob_siddump tools enable you to read and change Windows
SIDs that are stored in schema 54 VOB databases. These tools are typically used for
moving VOBs from one Windows NT or Windows 2000 domain to another or to
an Active Directory domain, or for moving a VOB between a Windows host and
a UNIX host.

For more information, see the vob_sidwalk reference page and the Administrator’s
Guide for Rational ClearCase.

New View Database Format

This version of ClearCase uses a new view database format.

Existing view databases will be reformatted the first time the view is used after this
version of ClearCase is installed. You may also reformat the views manually using
cleartool reformatview. We recommend that you reformat views manually if they
have large databases. Doing so minimizes the chances that clients will experience
view access time-outs during the reformatting.

When a view database is reformatted, its size grows by about 50%, which increases
the size of the total view storage area by 10%.

Note: After a view is reformatted to the new ClearCase format, it cannot be
reformatted to an earlier format.
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Changes to Administration Console

In line with the transfer of ClearCase Web information from clearcase.rational.com

to www.rational.com, the URL pointed to by the Customer Site snap-in in the
Administration Console now points to www.rational.com.

Enhancement to Apply Label Wizard

The Apply Label Wizard now can label the target of a symlink. On Step 3 of the
wizard, under Follow VOB symbolic link, click Yes to have the wizard find the target of
symlink and apply the label to that version.

Other Enhancements

The following sections discuss additional enhancements made to this version of
ClearCase.

chevent-Type Triggers Set to MODIFY_TYPE Now Fire Correctly

chevent type triggers now fire correctly when a trigger is set on MODIFY_TYPE. The
chevent operation for element triggers is now a suboperation of the MODIFY_ELEM
operation rather than the MODIFY_MD and MODIFY_DATA operations that it fell
under previously.

clearfsimport Checks for VOB Locks During Operation

The clearimport command now checks for VOB locks before processing an element or
version. If it detects a VOB lock, it shows a message indicating that the VOB is locked
and that it will wait 60 seconds to retry. It remains in this state until either the VOB is
unlocked or the user interrupts the import.

rmelem Use Now Restricted to VOB Owner or Privileged User

Beginning with this version of ClearCase, use of rmelem is restricted to the VOB
owner or privileged user unless no versions have metadata (labels, attributes, or
hyperlinks) and all branches were created by the user.

rmelem Triggers Fire When Symbolic Link Is Removed

Removing a VOB symbolic link with the rmelem command now causes all-element
rmelem triggers to fire. This works only for all-element trigger types and does not
work with per-instance triggers.
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recoverview Now Dumps or Loads Very Large Views

The view_server now dumps and/or loads very large views. Previously it would fail
to dump or load a view if the dump file exceeded 2 GB in size. The view_server now
creates multiple dump files for very large views, each of which is limited to about
1 GB.

Config Spec Editor Improvements

The version of the Config Spec editor introduced at this release fixes several defects,
mostly having to do with font sizes, scrolling, cut-and-paste functions, and line
length. The new editor no longer displays keywords in color and does not provide
write-protection on Config Spec fields derived from a view profile.

Improved Error Reporting for diffbl

Previously, diffbl displayed confusing error messages when it failed while comparing
imported baselines, initial baselines, or baselines/streams based off imported or
initial baselines, to other, similar baselines or streams. These messages described the
failure as resulting from the fact that the baselines or streams involved did “not share
a common ancestor (initial or imported) baseline”.

Now the error message describes the cause of the failure more accurately as resulting
from the fact that the baselines/streams “are derived from different import baselines
or the initial baseline”.

The CLEARCASE_GROUPS Environment Variable

This release supports the use of a new environment variable, CLEARCASE_GROUPS,
on Windows NT and Windows 2000. This environment variable is not supported on
Windows 98 or Windows Me.

If CLEARCASE_GROUPS exists for a user, ClearCase considers the semicolon-separated
list specified for this variable first when determining or displaying the groups to
which the user belongs. For example:

CLEARCASE_GROUPS=DOMAIN\ClearCase Users;DOMAIN\group1;DOMAIN\group5

The list can contain domain or local groups. It need not contain the group specified
by CLEARCASE_PRIMARY_GROUP, which is already treated specially if it has been
specified. If the user is a member of additional groups that are not specified in
CLEARCASE_GROUPS, those groups are considered after consideration of the groups
specified by CLEARCASE_GROUPS, up to a limit of 32 groups. For a user who is a
member of more than 32 groups (domain or local), CLEARCASE_GROUPS should
specify which of these groups should be considered when checking the user’s access
rights.
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Changes to ClearCase Commands

This section describes new commands, changes to existing commands, and commands
that have been made obsolete in this release of the product.

New Commands

Table 1 lists new commands in this version of ClearCase LT. In addition, the
clearprompt command is now available as part of the minimal developer installation.

Table 1 New Command in ClearCase LT Version 2002.05.00

Command Description

vob_sidwalk/
vob_siddump

Read and change Windows SIDs that are stored in schema
54 VOB databases.

New Options and Arguments

Table 2 lists new options and arguments to commands in this version of Rational
ClearCase LT.

Table 2 New Options and Arguments to Existing ClearCase LT Commands

Command New option/argument Use

chbl –nrecurse Causes the changes specified by
–full or –incremental to only apply
to the composite and not its members

chmaster –obsolete_replica
old-replica-selector

Transfers mastership of all objects
in the replica specified with
old-replica-selector

–dmodcomp
component-selector [,...]

Removes one or more modifiable
components

chproject

–spolicy policy-keyword [,...] Allows the specified policy to be
enabled or disabled by individual
streams in the project
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Table 2 New Options and Arguments to Existing ClearCase LT Commands
(Continued)

Command New option/argument Use

–target stream-selector Sets the default deliver stream for an
integration stream only

–ntarget Clears the default deliver stream
setting

–generate Forces an update of the stream’s
copy of the config spec

–policy policy-keyword [,...] Enables the specified policy

–npolicy policy-keyword [,...] Disables the specified policy

–recommended
{baseline-selector {,...}} |
default}

Sets the list of recommended
baselines for the stream

chstream

–nrecommended
{baseline-selector {,...}} |
default}

Clears the list of recommended
baselines previously set in a stream
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Table 2 New Options and Arguments to Existing ClearCase LT Commands
(Continued)

Command New option/argument Use

–deliver [ –to target-view-tag
]

Specifies a view attached to the
deliver target stream

–deliver [ –target
stream-selector ]

Specifies a nondefault deliver target
in the same or a different project

–rebase [ –stream
stream-selector ]

Specifies a stream to be used as the
source for the UCM rebase operation

–directory For each directory, considers only the
directory itself, not the directory or
file versions or VOB symbolic links
it catalogs

–nrecurse For each directory version, considers
the file and directory versions within
it, but does not descend into its
subdirectories

–follow Causes VOB symbolic links to be
traversed

–noautomerge Turns off automated merging of
directories

–query Turns off automatic merging for
nontrivial merges and prompts you
to proceed with every change in the
from-versions

–qall Turns off automated merging.
Prompts you to determine whether
you want to proceed with each
change

clearmrgman

–file mrgman-file Loads the specified merge manager
file

clearprompt –n Allows use of \n to represent the
newline character
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Table 2 New Options and Arguments to Existing ClearCase LT Commands
(Continued)

Command New option/argument Use

cleartool –status In interactive mode, returns the
status of each cleartool subcommand
executed.

describe replica-uuid-selector Displays the properties of a replica
by specifing its OID

–target stream_selector Specifies an alternate deliver target
stream in the same or a different
project

deliver

–baseline baseline-selector ... Specifies a list of baselines to deliver

–baselines Displays differences in terms of
member baselines for the named
composite baselines

diffbl

–nrecurse For composite baselines, displays
differences between the named
baselines themselves and not
between their members

lsactivity –contrib Displays contributing activities
delivered in an integration activity

lsbl –cview Lists baselines in the stream attached
to the current view

lsvob –family vob-family-uuid Lists the VOB with the specified
VOB family UUID

–adepends_on Adds dependency references to
baselines in its member components

–ddepends_on Drops dependency references to
baselines in its member components

–nact Makes a baseline only in the specified
component

mkbl

–component
component-selector

Specifies the component whose
dependency relationship you wish
to change. When used with –import,
specifies the component that contains
the label type
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Table 2 New Options and Arguments to Existing ClearCase LT Commands
(Continued)

Command New option/argument Use

mkcomp –nroot Specifies the nonroot directory for
components which only contain
baselines

mklabel –follow Label the targets of VOB symbolic
links

–policy policy-keyword [,...] Enables the specified policy

–npolicy policy-keyword [,...] Disables the specified policy

mkproject

–spolicy policy-keyword [,...] Allows the specified policy to be
enabled or disabled by individual
streams in the project

–target stream-selector Sets the default deliver target for an
integration stream only

–policy policy-keyword [,...] Enables the specified policy

–npolicy policy-keyword [,...] Disables the specified policy

mkstream

–in stream-selector Selects the parent stream of the
stream to be created

rebase –stream stream-selector Specifies the stream to be rebased

–abort (merge only) Cancels the command
rather than engage in a user
interaction; a merge takes place only
if it is completely automatic.

–blank_ignore (compare only) Leading and trailing
whitespace is ignored, and internal
runs of whitespace are treated as a
single space.

–qall (merge only) Turns off automatic
merging.

–query (merge only) Turns off automatic
merging for nontrivial merges.

xmldiffmrg

–visible_blank Displays blank spaces as visible
characters (character to be displayed
can be set using the xmldiffmrg
GUI).
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Obsolete Options and Arguments

The -title title option/argument pair, previously used by the ClearCase commands
chfolder, chproject, chstream, mkfolder, mkproject, and mkstream, is obsolete at
this release of the product.

In addition, the –generate old-object-selector option to the rename command is also
obsolete.

Obsolete Commands

The clearexport_ffile command is obsolete; use clearfsimport instead.

Other Changes

Redefinition of element types (mkeltype –replace) is no longer allowed in replicated
VOBs.

Changes to Documentation

The following major changes have been made to the documentation:

� Integration of UNIX and Windows material in a single Command Reference.

� There is significant reorganization of material in the following Rational ClearCase
manuals: Administrator’s Guide and the (online) Command Reference.

Unified Command Reference for UNIX and Windows

The Command Reference is now published in a single edition for both UNIX and
Windows. At the beginning of each reference page are tables that show the platforms
and ClearCase Product Family products to which the interface described applies.

Manual Reorganization

Large sections of material in the Command Reference have been moved to other
manuals, and some material from other titles has been moved to the Command
Reference.

� Certain build-related information that was formerly published in other titles is now
published in the following reference pages:
� clearmake.options
� makefile_aix
� makefile_ccase
� makefile_gnu
� makefile_pmake
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� makefile_smake
� makefile_sun

� Some reference pages that do not describe any user interface—but rather ClearCase
internals or concepts—have been removed from the Command Reference and the
information has been incorporated into other titles.

In particular, information from the following obsolete reference pages is now
published in the Administrator’s Guide for Rational ClearCase LT:
� abe
� admin_server
� albd_server
� db_server
� db_dumper/db_loader
� errorlogs_ccase
� license.db
� lockmgr
� registry_ccase
� type_object
� view
� view_server
� vob
� vob_server
� vobrpc_server

� A new reference page, intro, provides a broad orientation by organizing all
ClearCase Product Family commands into various lists.

� A new reference page, xmldiffmrg, describes the use of the XMLDiff/Merge tool,
in particular its command-line options and arguments.

Changes to the Command Reference

In previous releases, restrictions for commands were in a section called PERMISSIONS
AND LOCKS. In this release, the section is named RESTRICTIONS. The section
that was previously named Permissions Checking is now called Identities. There is a
new section named Mastership, which describes any restrictions applied when the
command is run in a replicated VOB.

The msdostext_mode reference page now describes the options –r and –f. The –r
option resets the line counters for elements of type text_file that have been changed
to a binary type, and the –f option forces a recalculation of the line count of all VOB
objects of type text_file.

22 Chapter 2 - What’s New in ClearCase LT



ClearCase
LT Hardware
and Software
Requirements

3

This section lists the basic platform, hardware, and software requirements for running
ClearCase LT software.

Supported Platforms

ClearCase LT 2002.05.00 runs on the platforms listed in Table 3.

Table 3 Supported Platforms for ClearCase LT Version 2002.05.20

Hardware platform Operating system

Intel x86 Windows NT 4.0 SP5 and 4.0 SP6a (but not 4.0SP6)
Windows 2000 SP1 and SP2
Windows 98 all versions (client only)
Windows Me (client only)
Windows XP Professional1

1 Rational ClearCase 2002.05.20 clients support the latest Windows 2000, Windows NT,
Windows Me, Windows XP Professional, and Windows 98 releases. Older releases of Windows,
such as Windows 95 and Windows NT 4.0 SP4, are no longer supported with this release; nor
do we support Windows XP Home. Customers who require support for earlier versions of
Windows should run an earlier version of ClearCase (4.1 or 4.2).

For more information about differences in features and functionality by platform,
see the Platform-Specific Guide in online help. To access the platform guide, go to
ClearCase help and click Help Topics.

Supported Platforms for ClearCase Web Servers

The following platforms support a ClearCase Web server:

� Windows 2000

� Windows NT 4.0

� Windows XP Professional
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All supported ClearCase platforms support the ClearCase Web interface. For details
about the Web servers and Web browsers supported on different platforms, see Basic
Software Requirements on page 25.

Supported File Systems

Table 4 lists the file systems that ClearCase LT supports. If a file system does not
appear on the list, it is not supported. Inform Rational Technical Support or your sales
representative of any concerns you have about this list.

Table 4 Supported File Systems by Platform

Platform Supported file systems

Windows NT FAT, NTFS, LANMAN, NFS

Windows 98 FAT, FAT32

Windows Me FAT, FAT32, LANMAN

Windows XP
Professional

FAT, FAT32, NTFS, LANMAN

Windows 2000 FAT, FAT32, NTFS, LANMAN

Windows/UNIX Interoperation

ClearCase LT clients access files in UNIX VOBs through the ClearCase File Server
(CCFS) using standard TCP/IP based networking. Similarly, ClearCase LT UNIX
clients can access files in Windows VOBs.

For more information about CCFS, see the Administrator’s Guide for Rational
ClearCase LT.

Hardware Requirements

This section describes hardware requirements for installing and running ClearCase LT
Server and ClearCase LT Client software.

Disk Space Requirements for the Release Area

The file system of the networkwide release host must have sufficient disk space to hold
the release area. The minimum disk space required for release areas on different
platforms is shown below:
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Windows NT

Windows 2000

140 MB

140 MB

Disk Space Requirements for Individual Hosts

Table 5 shows the approximate disk space requirements for a new installation of
ClearCase. These figures are for ClearCase files and upgraded system files only. In
addition to the requirements below, the installation needs 15 MB of temporary disk
space.

Table 5 Disk Space Required for ClearCase LT Files and Upgraded System
Files

ClearCase LT software Disk space required (MB)

ClearCase LT Client 88

ClearCase LT Server 125

In addition, any host that will have view directories needs enough disk space to
contain all files loaded into the views and all view-private files added to the views.
The amount of space required depends on the number and sizes of the files in the
views.

The ClearCase LT server must have enough disk space to contain the files and
databases used for storage of VOB- or view-storage directories. The amount of space
required depends on the characteristics and use of the VOBs and views.

Software Requirements

This section describes software requirements for running ClearCase LT.

Basic Software Requirements

ClearCase LT requires the following software on Windows NT, and Windows 2000:

� Windows Workstation or Windows Server

� Internet Explorer (5.0.1 SP2 or later: Internet Explorer does not have to be the
default browser, but is required for use of some ClearCase features, including
the ClearCase Explorer, the HTML Diff Merge tool, the ClearCase Automation
Library (CAL), and the ClearCase Administration Console. The recommended
version is 5.5 SP2.
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� If acting as a ClearCase Web server: Web server software, either Apache (version
1.3.14 and above), iPlanet Enterprise Server (version 4.1 SP8 through 6.0), or
Microsoft Internet Information Server (IIS 4.0 for Windows NT systems, IIS 5.0 for
Windows 2000 and Windows XP Professional systems). Note that Apache is not
supported as a ClearCase Web server on Windows XP Professional at this release.

� If acting as a server for the ClearCase integrations with FrontPage 98, FrontPage
2000, Visual InterDev, IIS Web server software and the FrontPage Server Extensions
(FPSE).

� An Adobe Acrobat Reader, version 3 or later, to access the online manuals, which
are in PDF format.

� On any system accessing ClearCase through the Web interface, a Web browser;
either Netscape (version 4.72 through 4.78) or Internet Explorer (version 5.01 SP2
through 5.5 SP1). Netscape 6 is not supported. (Note that it is not necessary to
install ClearCase on such a system.)

ClearCase LT requires the following software on Windows 98 and Windows Me:

� Client for Microsoft Networks (shipped with Windows 98 and Windows Me)

� Internet Explorer 5.0.1 SP2 or later: Internet Explorer does not have to be the
default browser, but is required for use by some ClearCase features, including the
ClearCase Explorer, the HTML Diff Merge tool, and the ClearCase Automation
Library (CAL). The recommended version is 5.5 SP2.

� An Adobe Acrobat Reader, version 3 or later, to access the online manuals, which
are in PDF format.

� On any system accessing ClearCase through the Web interface, a Web browser;
either Netscape (4.72 through 4.78), or Internet Explorer (5.01 SP2, 5.5, or 6.0).
(Note that it is not necessary to install ClearCase on such a system.)

Although the standard ClearCase LT interface is not supported on Windows XP Home
systems (and the product cannot be installed on such systems), the Web interface can
be accessed from a Windows XP Home system using Internet Explorer 6.0.

Using ClearCase and Windows NT Server Domains

ClearCase is a distributed client/server application; many operations initiated on
client hosts are completed by server processes elsewhere in the network. Therefore,
all ClearCase hosts running Windows NT or Windows2000 must belong to a
Windows NT Server domain or an Active Directory domain, except as noted in the
Administrator’s Guide for Rational ClearCase LT. On all Windows 98 hosts, the Client
for Microsoft Networks component in Network properties must be configured to log
on to a Windows NT Server domain or an Active Directory domain.
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To use ClearCase from a supported Windows host, you must log on to a domain
account (not a local, per-system user account). For more information about
Windows NT Server Domains, see the Administrator’s Guide.
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Getting Started 4

This section contains information to familiarize you with installing, setting up, and
using ClearCase LT software.

Installation and Licensing

This section contains an overview of information on installing and licensing
ClearCase LT software.

Pointer to Installation and Licensing Information

Refer to the Installation Guide for ClearCase LT for installation information. It provides
instructions on installing ClearCase LT Server and ClearCase LT Client software, lists
software prerequisites, and contains information about removing old versions of
Rational software and troubleshooting.

Refer to the License Management Guide for Rational Suite to see licensing information
necessary for installation and initial operation of ClearCase software.

If you have a floating evaluation license for ClearCase LT or for ClearCase LT and
another Rational Suite product, you must install a FLEXlm server to activate your
evaluation license. You can activate your floating evaluation license from the Rational
License Key Administrator window by clicking License > Enter a License. For more
information on installing a FLEXlm server, refer to the License Management Guide.

Installation Issues

This section discusses restrictions or defects that involve the installation of the
ClearCase product. Take into account the information in this section before or during
installation to be sure that ClearCase software or particular features are installed
properly.

Installing Java VM with Internet Explorer

A Java virtual machine (VM) is required for the ClearCase Web interface. However,
recent versions of Microsoft Internet Explorer no longer install the VM by default. For
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these versions, you must perform a custom installation of IE, selecting the Microsoft
virtual machine component.

Setting Up the VisualAge for Java Integration

The ClearCase integration with Visual Age for Java enables you to use ClearCase
source control functions, such as checking out, modifying, and checking in your files,
without leaving the Visual Age for Java IDE or starting another application.

To use the VisualAge for Java ClearCase integration, you must install both VisualAge
for Java and ClearCase, in either order, and then run the VisualAge for Java Integration
Configuration Wizard. This section describes all three procedures.

Installing VisualAge for Java

1 Run the installation program for IBM VisualAge for Java Version 3.5, Enterprise
Edition. Follow the installation instructions and prompts.

2 During the installation, select the Custom option. In the list of components to
install, select the External Version Control option.

3 Download and install the latest patch from www.ibm.com for the VisualAge for
Java Version 3.5, Enterprise Edition.

Installing ClearCase

If ClearCase is already installed and running on your system, skip this procedure. If
ClearCase is not installed, install it as you normally would.

Running the Configuration Wizard

After both VisualAge for Java and ClearCase are installed, you must run the VisualAge
for Java Integration Configuration Wizard. Select one of the methods listed here.

� If you installed ClearCase using the procedure titled Installing ClearCase in this
section:

Click Start > Programs > Rational ClearCase Administration > Integrations >
VisualAge for Java Integration Configuration.

� If ClearCase was previously installed or if the VisualAge for Java Integration
Configuration shortcut menu does not appear in the Integrations menu:

1 Click Start > Run.

2 In the Run window, enter the path to the file, vaj_config.exe, in the bin
folder of your ClearCase installation. For example, a typical path is
C:\Program Files\Rational \Clearcase\bin\vaj_config.exe.

3 Click OK.

30 Chapter 4 - Getting Started



Set CLEARCASE_PRIMARY_GROUP on Windows Systems

ClearCase access controls consider domain group membership information when
determining a user’s rights to access ClearCase data. Because of a bug in Windows NT,
a user who logs on to a domain account may not be assigned the primary group
specified by the Windows NT domain account management tools.

To work around this bug, we recommend that you set the user environment variable
CLEARCASE_PRIMARY_GROUP to refer to the correct primary group. The value of
this variable must be the name of an existing domain group that meets all of the
following requirements:

� It includes the user as a member.

� It appears on the user’s group list.

This environment variable must be set on every ClearCase host. On Windows NT
systems, you set the value of CLEARCASE_PRIMARY_GROUP using the System icon
in Control Panel. On Windows 98 or Windows Me systems, you must set the value
of CLEARCASE_PRIMARY_GROUP in the autoexec.bat file on each system that runs
ClearCase.

For more information on CLEARCASE_PRIMARY_GROUP and ClearCase access
controls, see the Administrator’s Guide for Rational ClearCase LT.

Deinstalling ClearCase May Remove Web Interface Views

By default, views for Web interface users are created under the host data directory
for ClearCase (ccase-home-dir\var). If ClearCase is deinstalled, the view directories are
deleted, but the views remain registered. To avoid leaving entries for nonexistent
views in the ClearCase registry, do one of the following:

� Remove any views created by Web interface users before you remove ClearCase
from a Web server that is used to provide access to the ClearCase Web interface.

� Use the –view_storage option in the ccweb.conf file to designate some other
location for Web interface views.

Installation of UCM Integration with ClearQuest

To use the UCM integration with Rational ClearQuest, take into account the following
issues with the compatibility and version support of the following elements:

� ClearCase version (client and server)

� ClearQuest version
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� UCM schema package

� ClearQuest metaschema feature level

Consider the following points:

� The feature level of the metaschema for ClearQuest 2001.03.00 database is 3. The
feature level for ClearQuest 2001A.04.00 or 2002.05.20 database is 5.

� A ClearCase 2002.05.20 client requires either a ClearQuest 2001A.04.00 or a
ClearQuest 2002.05.20 client, because the integration of UCM with ClearQuest
uses new ClearQuest API calls.

As a rule, the UCM integration is supported on all platforms that are common to both
ClearCase and ClearQuest clients. It is important to note that for any given release,
ClearCase and ClearQuest may not support all of the same versions of a particular
vendor’s operating system. The UCM integration is therefore only supported on the
set of operating system versions that are supported by both ClearCase and ClearQuest.
For example, ClearQuest doesn’t support 64-bit versions of Solaris and HP/UX but
ClearCase does. The integration, therefore, only supports the 32-bit versions.

Table 6 shows the compatibility of different releases of ClearCase and ClearQuest, the
UCM package revision number, and the ClearQuest database feature level.

Table 6 Supported Integrations Between ClearCase (Using UCM) and
ClearQuest

ClearCase
release

ClearQuest releases
UCM package
revision
numbers

ClearQuest
database feature
levels

Release 4.1 2000.02.10, 2001.03.00 2.0 3

Release 4.2 2001A.04.00,
2001A.04.20, 2002.05.00

2.0, 3.0 3, 5

Release 4.2 +
patch

2001A.04.00,
2001A.04.20, 2002.05.00

2.0, 3.0, 4.0 3, 5

Version
2002.05.20

2001A.04.00,
2001A.04.20, 2002.05.00

2.0, 3.0, 4.0 3, 5

To upgrade to Release 4.2 from 4.1 and continue to use your integration of UCM with
ClearQuest, you must perform the first two steps. The last two steps are optional.

1 Install ClearQuest.

2 Install the ClearCase client (or both ClearQuest and ClearCase simultaneously).
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3 Upgrade your UCM-enabled ClearQuest schema with the new version of the
UnifiedChangeManagement package.

4 Upgrade your ClearQuest user database to the new version of the schema.

Rational ClearQuest Compatibility with ClearCase LT

ClearCase LT supports the option of integration with Rational ClearQuest. You can
integrate the software in two different ways:

� If you install ClearCase LT with the Unified Change Management (UCM) option,
integration with the version 2001A.04.00 or 2002.05.00 of ClearQuest is supported.
If you have an older version of ClearQuest, you must upgrade to one of these
versions before configuring the integration.

� If you install ClearCase LT without the UCM option, you can integrate with
ClearQuest Version 2001A.04.00 or later using the ClearCase-ClearQuest
integration 1.0.

Note: Support the UCM/ClearQuest integration is not provided for AIX platforms
in version 2002.05.00 of ClearCase.

Invalid Install Option

A network installation of Rational Suite installs both ClearCase LT Client and the
optional Rational Shipping Server feature. Because this is an invalid combination,
the Shipping Server installation is disabled after installation. Only ClearCase LT
Client can be run.

Similarly, a user can explicitly install this invalid combination, with the same result:
the Shipping Server installation is disabled and only ClearCase LT Client can be run.

Rational Suite Network Installation, Rational Shipping Server Not
Supported With ClearCase LT

The Rational Suite installation program has an option for a “network” installation on
the Setup Configuration dialog box (see Rational Suite Release Notes). This option
is not supported when installing ClearCase LT Client or ClearCase LT Server. We
recommend performing a typical installation of ClearCase LT software.

This situation occurs because the ClearCase LT client and the Rational Shipping Server
are not compatible on the same system. If you select the network suite installation of
ClearCase LT, both the ClearCase LT Client and Shipping Server are installed, but the
Shipping Server is disabled. Similarly, if you select both as part of a custom install,
both are installed, but the Shipping Server is disabled.
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ClearCase Client Computers Need Consistent Character Encoding

All ClearCase client computers that access a common set of VOBs and views must use
a single common character encoding system. If all computers are not configured this
way, ClearCase operations may fail or produce confusing or unreadable output.

For example, the Japanese SJIS and Japanese EUC encoding systems are available.
They both represent Japanese characters but are incompatible. For this reason, you
cannot mix SJIS and EUC in ClearCase clients.

Notice for expat XML parser

This product incorporates the expat XML parser 1.0 under the Mozilla 1.1 license
available at www.mozilla.org/MPL/MPL-1.1.txt. The source code version of the expat XML
parser is available at www.jclark.com/xml/expat.html.

Platform-Specific Information Relating to Installation

This section provides information that varies from platform to platform. The
Installation Guide for Rational ClearCase LT specifies when you will need this
information and defines the terms used in this section.

Operating System Vendor Web Site

You can find up-to-date information on Microsoft Windows operating system issues
at the Microsoft Web site, www.microsoft.com.

ClearCase LT Patches Incorporated in This Release

ClearCase LT 2002.05.00 incorporates all ClearCase patches since the release of
ClearCase Release 4.1. Table 7 shows the specific ClearCase patches.

Table 7 ClearCase Patches Incorporated in This Release

Patch stream Last patch incorporated

ClearCase 4.1 clearcase_p4.1.NT-21 and earlier

ClearCase 4.2 clearcase_p4.2.NT-5 and earlier
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Upgrading from a Previous Release

This section discusses issues involved in upgrading from a previous version of
ClearCase LT.

The Installation Guide for Rational ClearCase LT provides information necessary
to install ClearCase LT. Here is some general information to keep in mind about
upgrading:

� Make sure that all views and VOBs are fully backed up. For information on backing
up VOBs and views, see the Administrator’s Guide for Rational ClearCase LT.

� You do not need to upgrade your license server or get new ClearCase licenses.
Licenses work with any version of ClearCase product family software, and
ClearCase Version 2002.05.00 hosts can use a ClearCase license server running
a 4.x version of the software.

� Be sure that VOB and view servers are upgraded before you upgrade client hosts;
Version 2002.05.00 clients cannot access VOBs or views on hosts that are running
an earlier release of ClearCase.

� Before upgrading to a new ClearCase release, you must complete all deliver
operations that are in progress.

See also Installation Issues on page 29.

Upgrading to the New Feature Level for UCM PVOBs

This version of ClearCase introduces a new feature level, FL3, to support some of its
new functionality.

To enable Version 2002.05.00 in UCM environments, you first install Version 2002.05.00
on all systems in a specific order (for UCM, this order is different from the order
required at previous releases of ClearCase and MultiSite), then raise the feature
level of VOBs and PVOBs, and finally set the recommended baselines. Following is
the procedure:

1 Install Version 2002.05.00 on ClearCase hosts in the following order:

a The license server.

b The registry server
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c VOB servers on all replicas

d All clients (clients must be upgraded, or will be inoperable)

2 Raise all PVOBs and VOB families to FL3 see the reference page for chflevel.

3 Set the recommended baselines on integration streams that are in use; otherwise,
existing development stream configurations may be unexpectedly changed when
you perform a rebase -recommend operation.

For more information, see the ClearCase white paper on migrating to Version
2002.05.00 on the Rational Web site, www.rational.com/support/products/clearcase.jsp.

If servers are upgraded to Version 2002.05.00 before all client systems have beem
upgraded, new VOBs must be created on servers that run ClearCase Release 4.x,
because Release 4.x clients cannot communicate with VOBs created on systems that
run the new release.

After you upgrade the feature level on your PVOBs, you must also set the
recommended baselines on integration streams that are in use. If you do not, existing
development stream configurations may be unexpectedly changed when you perform
a rebase -recommend command.

For more information, see the ClearCase white paper on migrating to Version
2002.05.00 on the Rational Web site, www.rational.com/support/products/clearcase.jsp.

Evaluating This Release of ClearCase

To evaluate,Version 2002.05.00, you can install it on one or more test systems in your
existing environment of servers, clients, views, and VOBs and configure the test
systems to use your 4.x license server.

Alternatively, you can install Version 2002.05.00 using temporary evaluation keys on a
test system. For more information on evaluation mode, see the Installation Guide for
Rational ClearCase LT.

ClearQuest Compatibility with ClearCase

ClearCase LT Version 2002.05.20 can be integrated with Rational ClearQuest software
in two different ways:

� If you are using ClearCase with the Unified Change Management (UCM) process,
a UCM-ClearQuest integration is built in to this release; you can use it with
Rational ClearQuest Version 2002.05.20.

� If you are using base ClearCase (that is, not using the UCM process), you can
integrate with ClearQuest 2001A.04.00 or later using the ClearCase-ClearQuest
integration 1.0.
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Restrictions and
Guidelines for Using
ClearCase

5

This section provides restrictions on and guidelines for using Rational ClearCase
Version 2002.05.00 software that are considered noteworthy. These are not considered
defects because the behavior reported is not expected to change in a future release
of the product.

Guidelines for Using UCM

The following sections provide guidelines for using UCM.

PVOB Feature Level Requirements

This version of ClearCase introduces a new feature level, Feature Level 3 (FL3).
To support all of the new UCM functionality provided with the new release, a
PVOB must be upgraded to the new feature level. Until a 2002.05.00 PVOB has been
upgraded to FL3, it will support ClearCase Release 4.x clients as well as Version
2002.05.00 clients, but without providing support for all the new UCM functionality
delivered with the new release.

Specifically, the following new features are not supported, even on 2002.05.00 clients
accessing 2002.05.00 servers, until the feature level of the associated PVOB has been
raised to FL3:

� Creation of baseline dependencies (composite baselines)

� Creation of components without root directories

� Using composite baselines to configure a stream

� Creation of sub-VOB components

� Creation of nested streams

� Support for relationships between a single PVOB and multiple ClearQuest user
databases

Installing this software on a PVOB server that is running a previous release of
ClearCase does not automatically change the PVOB’s feature level; you must raise the
feature level manually. Before raising the feature level, all ClearCase clients accessing
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that PVOB must be upgraded to Version 2002.05.00. ClearCase UCM operations will
fail on clients that run previous versions of ClearCase if they try to access a PVOB
whose feature level has been upgraded to FL3.

When Setting Up a Project, Make Components Read-Only Initially

This release of ClearCase supports the ability to change a stream’s configuration from
one using a modifiable component to one using a nonmodifiable one. However, we
generally recommend that components initially be specified to be nonmodifiable
when creating a new project. After verifying that the project builds and tests correctly,
update the project policies to allow modifications to any or all components.

Check In to Non-UCM VOB from UCM View if ClearQuest Is Enabled

If, in a UCM view, you check out or check in an element from a VOB that is not a
UCM component, you should not have to select an activity, because that operation
is not captured in a change set.

However, if you are in a view that is in a project enabled for ClearQuest, both the
Check Out dialog box and the Check In dialog box force you to select an activity
even though one is not really required.

Workaround: Select the activity; it will be ignored.

Notes on Using the UCM-ClearQuest Integration

The UCM process in ClearCase is enhanced for sites that have installed Rational
ClearQuest by a very tight integration between the activity management provided
by UCM and the change request management provided by ClearQuest. Use the
following guidelines with the UCM-ClearQuest integration.

Transitioning an Activity Enabled for ClearQuest After Delivery
Using the CLI

If the Do ClearQuest action after delivery policy is enabled on a UCM project,
delivery of a UCM activity enabled for ClearQuest using the command-line interface
(CLI) may result in an attempt to transition the activity to a Complete state type.

If the activity record has a field that must be filled in before it can transition to the
Complete state, the program displays an error. An example is the Defect record type
in the default UnifiedChangeManagement schema, whose Resolution field must
be nonempty before it can be resolved.

Workaround: Modify the UCU_CQActAfterDeliver global script to include code
similar to that below, which fills in the Resolution field when the activity is delivered.

REM Add complete resolution code

38 Chapter 5 - Restrictions and Guidelines for Using ClearCase



REM Defect record type requires Resolution field to be non-empty
’Get hook’s session context
Set Session = GetSession()
’Get the entity
Set entity = Session.GetEntity(entity_type,entity_id)
REM If record type is "Defect"
... If(entity.GetEntityDefName = "Defect") Then
REM If Resolution field is empty
... If(entity.GetFieldValue("Resolution").GetValue = "") Then
REM Fill in required field

session.EditEntity entity, "modify"
Call entity.SetFieldValue("Resolution", "Fixed")
msg = entity.Validate

REM Remember to do some action if validate fails
entity.Commit
End If End If

For information on editing entities, see the ClearQuest API documentation.

Schema Requires Submitted State

If you are applying the UCM package to a custom ClearQuest schema (as opposed to
using the out-of-the-box Unified Change Management schema), be aware that this
package depends on the existence of a state whose name is Submitted. If your custom
schema does not include a Submitted state, you can apply the package to your schema
by using one of the following methods:

� Before applying the package, temporarily rename the state that is the target of the
Submit action to Submitted. After applying the UCM package, you may rename
it to its original name.

� Create a dummy state called Submitted, and assign its state type to Complete. If
you do this, you must also create a dummy action whose target is the Submitted
state. After applying the UCM package, you may delete the dummy state and
action.

ClearQuest Script Error Text Not Reported

Using the UCM-ClearQuest integration, you can customize the Check Before Deliver
ClearQuest Visual Basic policy script. However, if the script as customized contains
an error that causes the Visual Basic interpreter to display an error exception, the
Deliver dialog box reports this error like this one:

An error occurred during the deliver.
Unexpected error in deliver.

It does not report the actual error exception text, which would enable the user to
diagnose the problem script.
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Workaround: To see the error exception text, use the cleartool deliver command.

Changes to UCM CustomQuery1 Do Not Appear in Dialog Box

When using the UCM-ClearQuest integration, the list of records displayed in the list
on the Add To Source, Check Out, and Check In dialog boxes is generated by running
the UCMCustomQuery1 query, which can be customized. (To see the effect of your
changes, you must click File > Save to save the query edits.)

However, if you copied the Public Queries UCMCustomQuery1 query to your
Personal Queries folder and edited it there, the changes are not immediately visible.
To see your changes, you must stop the integration server process.

On Windows NT or Windows 2000

1 Start the Task Manager and click the Processes tab.

2 From the list, select CQINTS~2.EXE or CQINTSVR11.EXE.

3 Click End Process.

On Windows 98 and Windows Me

1 Press CTRL+ALT+DELETE.

2 From the list, select CQINTSVR11.

3 Click End Task.

After stopping the process on your computer, open the dialog box again. Further
edits to /PersonalQueries/UCMCustomQuery1 appear without your having to shut down
the process again.

ClearCase Client Loops on Windows 98 Systems with ClearQuest

If ClearQuest software is incorrectly configured (for example, connected to the wrong
database), ClearCase operations such as checking an element out will fail, because
the ClearQuest record corresponding to the UCM activity cannot be located. On
Windows 98 systems, this failure can cause the dialog box to be “stuck” so that clicking
Cancel does not remove it. To work around the failure, do one of the following:

� Click another window before clicking Cancel.

� Press CTRL+ALT+DEL to start the Task Manager; in the Task Manager, kill the
program that is displaying the dialog box.

Cannot Import UCM-Enabled Records from ClearQuest Database

In general, you cannot import UCM-enabled records from a ClearQuest database;
ClearCase cannot guarantee that UCM information that references an arbitrary
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ClearQuest database is correct. However, this restriction does not prevent data
recovery in the event of a data loss. Records may be successfully imported into a
ClearQuest database if all of the following conditions are true:

� The records have been backed up from that database.

� The name of the database has not changed.

� The ClearCase UCM information in the record is still valid.

Cannot Delete a Project Record in ClearQuest

If you are working with a UCM project that is linked to a ClearQuest user database
and attempt to delete the project record, you get a run-time error. You cannot
delete the record or undo the CommitAction hook. The workaround is to use the
squid_patch utility to force the ucm_vob_object field of the orphaned project to 0.

Changing Name of ClearQuest Record Type Causes Error

In the UCM-ClearQuest integration, if you change the name of the ClearQuest record
type after activities have been linked to ClearQuest records of that record type, the
integration displays an error message when you try to set one of those activities in
a view. To change the name of a record type, do so before any activities are linked
to records of that record type.

Opening Multiple Nested ClearQuest Forms May Cause Crash

The ClearQuest integration for UCM does not prevent you from doing the following:
open a ClearQuest form; go to the form’s UnifiedChangeManagement page; use the
shortcut menu in the change set to open a ClearCase dialog box; and then select
Activity Properties, which opens a second ClearQuest form.

However, if you follow the above steps, the second ClearQuest form does not function
correctly. In particular:

� The Apply, Revert, and Cancel buttons on the form have no text.

� If you attempt to go to the form’s UnifiedChangeManagement page, then close
the form, you get this error:

Unable to load message ID 14090 from resources

ClearCase then crashes.

Therefore, we recommend that you not use the above procedure to open a second
ClearQuest form.
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Must Rerun ClearQuest Maintenance Tool If ClearQuest Is
Reinstalled

If you upgrade ClearQuest, the registry settings that keep track of the current
database are removed. You must run the ClearQuest Maintenance Tool to reestablish
the default database for the computer.

Availability of Check Mastership Policy

The ClearQuest page of the UCM project Properties Browser has a check box for the
policy Check mastership before deliver. This is supported with the UCM 3.0 and
UCM 4.0 package revisions. If you are using the 2.0 package revision, the check box
is unavailable.

Changing a Project Name Does Not Automatically Update
ClearQuest

If information in ClearQuest records is changed from a ClearCase application, such
as cleartool or the UCM Project Explorer, the ClearQuest display may not always
reflect the actual contents of the database. To refresh the display, close and reopen
the database from the File menu.

When Running Integration, Certain Operations Do Not Require
ClearCase Installed

The following ClearQuest operations do not require ClearCase to be installed on the
user’s system when working with the ClearCase-ClearQuest integration:

� Submitting new CQ records (Defect, BaseCMActivity, or UCM_Project).

� Modifying an activity record if its headline field has not been changed.

� Modifying a UCM_Project record if its name field has not been changed.

Rebasing a Stream

A stream can be rebased to a baseline that meets the following criteria:

� The baseline is not from the stream that is being rebased.

� The baseline is labeled. Baselines created by deliver operations are not labeled by
default. For information about how to change a baseline’s labeling status, see
the chbl reference page.

Additional rules apply to integration streams and development streams in selecting a
baseline:
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� An integration stream can be rebased only to a baseline created in another project
or to an imported or initial baseline of that project.

� A development stream can be rebased to a baseline that meets one of the following
criteria:

� The baseline was created in its parent stream.

� The baseline is in its parent stream’s foundation.

� The baseline was created in a stream other than its parent stream and is
contained in its parent stream. A baseline is contained in another baseline if all
changes in the first baseline are included in the second baseline.

Rebase is typically used to advance a stream’s configuration, that is, to replace
its current foundation baselines with more recent ones. However, under certain
conditions, rebase can be used to revert a baseline, and to add or drop a component in
a stream’s configuration. It can also switch to a baseline that is neither an ancestor nor
a descendant of the current foundation. The rules explained above are general rules
for all rebase operations. You need to satisfy only the general rules when adding a
component to a stream. When you advance, revert, drop, or switch a baseline, you
need to satisfy the general rules and some additional ones.

� To advance a stream’s configuration, the new baseline must contain the current
foundation baseline.

� To revert or drop a baseline for a component in a stream, one of the following
conditions must be met:

� The component is nonmodifiable.

� The component is modifiable but has not been modified in the stream, and the
component is not in the configuration of any child streams.

� To switch to a baseline that is neither an ancestor nor a descendant of the current
foundation, one of the following conditions must be met:

� The component is nonmodifiable.

� The component is modifiable but has not been modified in the stream, and the
component is not in the configuration of any child streams.

� The component has been modified but the new baseline contains the current
foundation baseline, and the component is not in the configuration of any
child streams.

These rules ensure that any changes made in a stream are not lost when the
configuration changes.
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Clear Recommended Baseline Setting if Baseline Is Removed

If a baseline is recommended for a stream, and then that baseline is removed, clear
the recommended baseline setting in the stream by typing the command chstream
–nrecommended. Then you can set new recommended baselines by using the
command chstream –recommended.

Attache Does Not Support UCM Commands

Attache users cannot use ClearCase UCM commands.

Delivering Changes to a Read-Only Component

The deliver operation cannot allow changes to a read-only component. This situation
can occur if someone changes the component modifiability in your project. The actions
you take depend on whether you are doing an intraproject or an interproject deliver.

For an Intraproject Deliver

If you are performing an intraproject deliver for a component that was previously
modifiable, you receive a warning message. Decide what can be delivered from your
stream. If the changes in the other components are independent of the changes in the
read-only component, move the versions from the read-only component into a new
activity. Deliver all activities in your stream except the new one.

If any changes in the other components depend on changes to the read-only
component, decide whether those versions can be separated into a new activity. This
may involve not delivering a subset of activities in your development stream.

If there are dependencies among the versions, your stream may no longer be
deliverable to its default target. Determine whether there is a project to which you can
deliver the changes. The project integrator may have to create a new development
stream in this project and use findmerge (findmerge -insert) to selectively merge the
changes from the versions into the new stream. Deliver cannot be used.

As a last resort for an intraproject deliver, you can remove all the versions (rmver) that
should not have been made. Also, remove all changes dependent on that component.
You must use rmver -xhlink to remove the versions from the change set. You may
need to manually recode some changes to remove the dependence on the changes to
the read-only component.

For an Interproject Deliver

If you are performing an interproject deliver, you can also receive a warning message.
The project from which you are delivering and the target project can have differences
in component modifiability at any time. You have the following choices:
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� Set the policies on the target stream and target project so that deliver can ignore
the changes in both the read-only component and in other components that are
dependent on the changes to the read-only component.

� Isolate the changes in the read-only component and changes in other components
that are dependent on the changes to the read-only component. Deliver only the
activities that contain changes to modifiable components.

Recommending a Baseline

You can recommend a baseline for a stream if the baseline is from the stream or the
stream’s foundation.

For a baseline not from the stream or the stream’s foundation, the following rules
apply:

� The baseline must be from the same project as the stream.

� The baseline must be contained in the stream, which means the baseline has been
delivered to the stream, or the stream has rebased to the baseline or one of its
descendents.

� The baseline must contain the current recommended baseline, which means it
must be a descendent of the current recommended baseline.

You are not required to recommend a baseline for every component in the stream’s
configuration.

You can clear the list of recommended baselines. Note that doing this step alone will
cause problems when existing development streams rebase to the recommended
baselines. The rebase operation will attempt to drop all baselines in the development
streams’ configuration. This operation will probably fail or produce errors and is,
therefore, not desirable.

You can choose to reset the recommended baselines to baselines from the stream or
the stream’s foundation with or without clearing the recommended list. This allows
the stream to return to a known correct state after being changed inadvertently to a
bad list.

Delivering Selected Activities to a Nondefault Target

Delivering selected activities to a nondefault target is subject to the following
restrictions:
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� If the full set of activities in the stream violates one of the policy settings, you will
not be allowed to proceed with the selected activity delivery, even if the selected
activities would not violate the policies.

� If the full set of activities in the stream contains changes from a foundation
baseline, you will not be allowed to deliver selected activities from this stream,
regardless of the deliver policy settings.

� If the set of activities you want to deliver contain versions in components that are
not visible in the target stream or are not modifiable by the target stream, you will
not be allowed to deliver the set of activities. Delivering an activity requires that
you deliver all versions in all components in the change set. You can move the
versions of the missing or nonmodifiable components into another activity.

Remote Deliver May Fail if Remote Site Has Not Synchronized

It is possible for a remote deliver to include changes to a component when the
component is nonmodifiable in the project. This only happens when the remote site
has not synchronized with the local site and does not know that the component has
been made nonmodifiable. When the integrator attempts to resume the remote
deliver, a check is made to ensure that no versions in nonmodifiable components
will be changed. If there are such versions in the deliver, the operation fails and the
user has to cancel the deliver operation.

Notes on Using the Base ClearCase-ClearQuest Integration

This section provides guidelines for using base ClearCase and ClearQuest together.

Support Policy on Modifying Perl Trigger Source Code

In this release, the integration includes a new trigger, which runs on Windows and
UNIX platforms. The release includes the source code, in the form of Perl scripts,
that the trigger uses. The Perl scripts include extensive comments that describe the
purpose of their classes. For additional source code documentation, including an
architectural overview and formatted class documentation, contact Rational Support.
However, Rational Support cannot and will not support changes that you make to this
source code.

Using ClearQuest with Long Version-Extended Pathnames

The base ClearCase-ClearQuest integration creates a ClearCase tab on your
ClearQuest screen. On this tab, if you right-click CC Change Set Objects and then click
View Details, the program displays data about a VOB element. If the version-extended
pathname is too long to fit in the dialog box, it cannot be viewed in its entirety,
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because the form does not support horizontal scrolling by default. You may want to
modify the form using the following procedure:

1 In ClearQuest Designer, check out the ClearQuest schema you are using.

2 Click Record Types-Stateless > cc_vob_object > Forms > cc_vob_object.

3 Select each text box and double its height.

4 Right-click a text box and click Properties.

5 Click the Extended tab.

6 Select the Horizontal Scroll Bar check box.

7 Repeat Steps 3 through 6 with the other text boxes.

8 Check in the schema.

9 Click Database > Upgrade Database to finish the changes.

If you wanted only the horizontal scrollbase on the name, do the following instead:

� In Step 3, select the Name box and double its height.

� In Step 4, right-click the Name box and click Properties.

� Ignore Step 7, which asks you to repeat the instructions.

Guidelines on Using the ClearCase Web Interface

The following restrictions and guidelines apply to using the ClearCase LT Web
Interface.

Restrictions on the Web Interface in a UCM Environment

If you are using the Web interface in a UCM environment, you cannot use the Web
interface to work effectively in projects enabled for ClearQuest. You can view
such projects, but you cannot perform any integration operations through the Web
interface; also, you cannot use the interface as a suitable client in a UCM project
enabled for ClearQuest.

Interactive Triggers Fail When Accessed Through Web Interface

The ClearCase Web interface supports noninteractive triggers. Interactive triggers,
such as those that attempt to read input or create a window, fail.

If a trigger attempts to read input using clearprompt, the ClearCase Web interface
prints this error:

clearprompt is not supported in the Web interface
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If a trigger attempts to read directly from standard input, it receives an error, because
standard input does not specify a valid file descriptor.

In addition, any trigger failure in the Web interface context displays this error message:

Interactive triggers are not supported in the Web interface. If the

trigger was interactive, it may have failed for that reason.

Trigger script writers can detect whether a trigger is running in the Web interface
context by checking for the environment variable ATRIA_WEB_GUI. It is set to 1 if you
are running in the Web interface context.

Note that the base ClearCase-ClearQuest integration is dependent on the operation
of interactive triggers; for this reason, the ClearCase Web interface is not a viable
interface for using that integration.

Restrictions on Comparison of Some Element Types

The Web interface does not support graphical (tree view) comparison of XML file
elements; the Web Compare tool displays a text-based comparison for elements of
type xml. When comparing HTML files, the program displays the differences in
the Compare screen as text, but includes hyperlinks to display the individual files
appropriately formatted using your default browser.

In addition, because the Compare tool in the Web interface handles only text files, it
does not support comparison of Rational Rose or Microsoft Word files.

Error When Checking In Large File from Windows NT Web Client

Windows NT 4.0 sends very large amounts of information to a Web server. This
behavior causes the ClearCase Web interface to fail when attempting to check in very
large files (on the order of several megabytes). This problem appears to be fixed
in Windows 2000.

Host Name Resolution Must Be Enabled on Web Interface Clients

The Java program used in the Web interface attempts to connect to the Web server
to transfer files. Web browsers only allow Java programs to open connections to the
server from which the programs were downloaded.

To enforce this rule, the Web browser on the Web interface client must be able to
resolve the Web server’s host name to an IP address. If you use a host name in a URL
that cannot be resolved by the client host, the Java program cannot connect to the
server. In this case, Web-interface file-transfer operations such as checkout, checkin,
and download fail.

If the Web server is being accessed through a firewall by means of a proxy server, the
proxy server being used must support DNS lookup outside the firewall.
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ClearCase Web Interface Problem in Overriding Primary Group

When the ClearCase Web server on Windows logs on to a client, it sets the primary
group to the designated primary group in the client user’s domain account. In Release
4.0, you could not override this group setting. As a result, sites that use domain
mapping to allow user accounts in multiple domains to share VOBs could not access
those VOBs through the ClearCase Web interface.

Workaround: Specify a configuration variable in the ccweb.conf file, and add a value
to the registry that enables domain mapping.

Adding the Variable to the ccweb.conf file

To enable a single Web server to support one primary group override, add
the –primary_group variable with a groupname value to the ccweb.conf file. The
allowable values for groupname are the same as for the CLEARCASE_PRIMARY_GROUP

environment variable. The ccweb.conf file must be located in ccase-home-dir\var\config. If
you need more than one primary group override, configure additional Web servers.

Setting the Registry

Typically, when domain mapping is used to allow users from multiple domains to
access the same VOB, each user must create the DomainMappingEnabled value (set to
1) in the HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion registry key.

To enable domain mapping for a Web server, create the DomainMappingEnabled
value in the HKEY_LOCAL_MACHINES\Software\Atria\ClearCase\CurrentVersion key on
the Web server machine. The value must be of type DWORD and set to 1.

If you log on directly to the computer instead of logging on through the Web interface,
user values for DomainMappingEnabled override the machine value.

Problems with Toolbar Menus When Using Netscape

Toolbar popup menus don’t close properly when running the Web interface using
Netscape Navigator. Rather than closing automatically when the pointer is moved
out of the menu location, they close only when you reselect the menu button.

Conflict Between Netscape and Earlier Versions of Exceed X Server
Windows

If you access the ClearCase Web interface using a Netscape browser on a Windows
system and also use a version of the Exceed X Windows Server earlier than 6.0, do
not let the Netscape window lose its focus to an Exceed window. Doing so causes the
Netscape window to restart any Java applets it is currently running, which interferes
with file transfer operations, for example, download, checkout, or checkin.
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Neither Internet Explorer nor Version 6.0 of the Exceed X Server has this problem.

Internet Explorer 5 May Terminate Display of Web Pages

Internet Explorer 5 terminates the display of Web pages early if the response
from the Netscape Web server is delayed. This may affect use of the ClearCase
Web interface because accessing VOBs may delay the Web server’s response.
The Microsoft Knowledge Base article Q226550, which can be accessed at
support.microsoft.com/support/kb/articles, describes how to download a patch to fix this
problem.

Required Internet Explorer Settings

To run the Web interface successfully, set the Internet Explorer setting Check for newer
versions of stored page to the value Automatically. To access this setting, click Internet
Explorer > Tools > Internet Options > Temporary Internet Files > Settings > Check for
newer versions of stored page.

ClearCase Web Interfacer Does Not Work with iPlanet Web Server if
ClearCase Is Installed in Program Files Directory

The Windows version of the iPlanet Web server does not allow a pathname for an
Additional Document Directory to contain spaces. Because the ClearCase Web
interface requires configuration as an Additional Document Directory mapping to
the web directory under the ClearCase installation directory, ClearCase cannot be
installed in a location which contains spaces (for example the Program Files directory)
if the iPlanet Web server is expected to provide the ClearCase Web interface.

Web Views Can Only Be Accessed Using the Web Interface

Web views can only be accessed from the Web interface; they cannot be used with
native ClearCase interfaces (for example ClearCase Explorer or cleartool). Various
native GUIs may allow selection of a Web view (for example as a deliver target),
but any attempt to access a Web view using a native ClearCase interfaces will result
in a warning or error message.

Preparing Old Web Views to Run with ClearCase 2002.05.00

Rational ClearCase Version 2002.05.00 introduces a new ClearCase Web interface.
This interface is not compatible with Web views created by previous ClearCase Web
interface clients. If you want to reuse existing Web views, we recommend that you
clean them up before you upgrade the ClearCase Web server host to ClearCase 5.0.

Use the following procedure:
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1 Check in all checked-out files and directories, or cancel the checkouts.

2 Make a note of the files and directories you have loaded into the view. You can
use this information to configure the view to load these objects after the Web
server host has been upgraded.

3 Unless the view contains important view-private files or directories (or hijacked
files that you cannot convert to checkouts and then check in), delete all files and
directories under the Web view root directory, but not the root directory itself.

Guidelines on Using the XML Diff Merge Tool

The tool presents some problems with scrolling:

� Windows restricts the height of a window to 32,767 pixels. This may not be enough
to display the contents of large XML files. If this maximum size is exceeded, XML
Diff Merge compensates for this restriction by reporting the number of lines that
are not visible. This line count is displayed in the title bar of any affected tree view
pane. The size (height) of the tree control window may be reduced by collapsing
tree nodes. When nodes are collapsed or expanded, the count of lines not visible is
updated. When the entire file is visible, the title bar indicator is removed.

The collapse branch, collapse level and collapse attributes operations can be
used to collapse many nodes in the tree at once. For navigating differences in an
especially large file, we recommend that you collapse the tree entirely by selecting
collapse branch on the root element, and then use the difference navigation
buttons to expose the individual differences.

� If a tree control is scrolled horizontally, and then the control is widened such that
the horizontal scroll bar is removed (the control is now wide enough to display the
entire horizontal contents), the tree remains scrolled horizontally. Its scroll position
should be pulled back to the left (zero).

Workaround: Scroll the control to the left (zero) before resizing it.

� When an attribute name node is collapsed, it also displays the attribute value in
the form ’name = "value"’. The length of this summary text should be measured
when computing horizontal scroll extents. Currently, name and value are measured
separately, and this may cause the horizontal scroll extent to be too small if the
’name = "value"’ line is the longest line.

Workaround: The right scrollbar button always scrolls, so any horizontal extent
can be made visible.

� When the display is horizontally scrolled, the background rectangle of some
attribute name nodes may not be computed correctly, causing a certain amount
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of the default selection rectangle to peek through. This default rectangle will be
colored in the user’s default selection background color.

Workaround: Make the tree control wider, instead of using horizontal scrolling.
The background rectangle will be displayed correctly.

Using Internet Information Server to Serve Web Pages from
a VOB

If you intend to use Internet Information Server (IIS) to serve Web pages within a view
and VOB, you must configure IIS to log on as a Windows NT domain user who has
access to that view and VOB data. Use this procedure:

1 Make sure that the views and VOBs serving the Web pages use NTFS, not FAT, for
storage.

2 Start the Services Control Panel program.

3 Double-click World Wide Web Publishing Service; a Service dialog box opens.

4 Click Manual startup type, and then click OK.

5 Create a domain user who is a member of the same primary group as ClearCase
users.

6 Make the user the Anonymous Login user for IIS:

a Click Start > Programs > Microsoft Peer Web Services > Internet Service Manager.

b Start the WWW service, if necessary.

c Double-click Service to open its property sheet.

d Enter the user name in the format domain\user, for example, rational\webclient.

7 Start the view or views from which you want to publish and mount the VOBs
you need.

8 Start the IIS service.

9 On the Directories tab, set aliases to directories in the VOB or VOBs.

IIS and ClearCase should now work together on the same computer.

Note: Whenever you restart your computer, always start views and mount VOBs
before you start the IIS service.
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Third-Party Integration Guidelines for This Release

ClearCase contains support for Visual Studio 6.0 (including Visual InterDev) tools
that use the Microsoft Common Source Code Control Interface (SCC) integration. It
also contains support for Microsoft Word, Microsoft FrontPage, Microsoft Office
2000, and Sybase PowerBuilder. This section contains guidelines on using ClearCase
with integrated products.

Using ClearCase with Microsoft Web Tools

ClearCase is integrated to work with FrontPage 98, FrontPage 2000, Visual InterDev,
Microsoft’s Save to Web Office 2000 functionality (Word, Excel, PowerPoint), and
Microsoft Internet Explorer 5 (IE5) Web Folders.

When using ClearCase with these programs and tools, follow the guidelines below:

� If you have been running the FrontPage integration in local mode with ClearCase
Release 4.0, you must upgrade to Version 2002.05.00:

1 Install Version 2002.05.00 on your client.

2 Start the Web Authoring Integration Configuration Wizard. To do so,
click Start > Programs > Rational ClearCase Administration > Web Authoring
Integration Configuration.

3 Select Local Mode Configuration.

� Users/Groups that are granted Front Page Server Extensions (FPSE) Author
rights must match the identities of the Users/Groups with write access to the
Web content VOB. In particular, granting Author rights to Everyone or to the
IIS Anonymous user is not supported.

� The ClearCase/FrontPage Web server maintains a cache of source control
information, including checkout status, user, time, and version. This cache is not
updated when source control operations are performed using ClearCase tools such
as the Version Tree Browser, or cleartool, rather than from within a Microsoft
Web program like FrontPage. For this reason, it is recommended that all source
control operations be performed from within the appropriate Microsoft Web tool.
In the integration with FrontPage 2000, the ClearCase commands Update View and
Refresh Source Control Status and the iisfix.bat script can be used to resynchronize
the cached source control information.

� Use of FrontPage borders and themes can cause many extra source control
operations to be performed, slowing integration performance.

� As described in the online help for the integration, users access files using a shared
snapshot view created for the ClearCase/Web tools integration on the ClearCase
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Web server; the view tag of this view is fp_hostname_default-web-alias-path. If a Web
uses the IIS Challenge/Response authentication method, this view must be located
on the IIS Web server, and the VOB must either be on the same IIS Web server or
on a UNIX VOB server configured to use CCFS.

� If you are attempting to import an existing Web with FrontPage Server Extensions
installed into a VOB, you must remove all vti* directories from the Web before
using clearexport_ffile and clearimport.

Using ClearCase with Visual InterDev

The integration of ClearCase Version. 2002.05.20 and Visual InterDev may cause
corruption and data loss. The problem occurs when user A checks out a file and
then user B checks out the same file; user A is permitted to check in before user B.
When attempting to check in the file, user A receives an error message and the file
becomes corrupt.

There are three ways to deal with multiple-checkout problems in Visual InterDev:

� Add all users who may potentially check out the same files at the same time to
the ClearCase domain group. This gives users permission to check in any files
checked out by another user.

� Enable simulated checkouts for all files in the Web content VOB. The actual
checkout occurs at checkin. This deferral allows multiple users to successfully
check out the same file at the same time. However, these checkouts appear only in
the Visual InterDev GUI. To enable simulated checkouts, change the value of the
registry key HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\

Performance\SystemFiles from the default value to the string value *.

� Disable the multiple-checkout functionality. To do so, you must turn on a new
registry key. After this new registry key is set, Visual InterDev enforces a single
checkout model. To disable multiple checkout functionality, add the new registry
key as a DWORD value:

HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\

FailCOIfAlreadyCO

If the value is set to 1, a checkout fails if the object is already checked out.

Using ClearCase with Microsoft Visual Studio

To use the ClearCase integration with Visual Studio, users must do one of the
following:
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� Install ClearCase after installing Visual Studio.

� When installing Visual Studio, choose the option to do a custom install. Then clear
the appropriate options so that you do not do the following:

� Install Visual Source Safe

� Make Visual Source Safe the source code control program

Using ClearCase with Microsoft Visual C++

ClearCase uses the Microsoft Common Source Code Control (SCC) interface to
integrate with the Microsoft Visual C++ available through Microsoft Visual Studio.
ClearCase has support for Visual C++ versions 5.0 and 6.0. You can switch between
SCC-support versions 5.0 and 6.0, but only one version can be enabled at a time.

The ClearCase SCC interface for Visual C++ 6.0 also supports Visual Basic 6.0, Visual
J++ 1.1, and Visual InterDev 6.0.

Using ClearCase with Visual Studio components requires no special configuration
on the part of the user. For more information, see the information on Developing
Software in online help.

Issues with Visual C++ Add-in Toolbar on Windows 2000

If you install Windows 2000 on a computer that currently runs Windows NT with the
Visual Studio integration and then reinstall ClearCase, the Visual C++ 6.0 Add-in
toolbar for the ClearCase integration contains five Version Tree buttons. All buttons
start the Version Tree Browser. To correct the problem, remove the ClearCase toolbar
and then re-add it:

1 Click Tools > Customize and click the Add-Ins tab.

2 Clear the ClearCase check box and close the dialog box.

3 Click Tools > Customize and click the Add-Ins tab.

4 Select ClearCase on the list and close the dialog box.

Changing ClearCase Properties for Visual C++ Projects

If you have existing Visual C++ projects in ClearCase and want to set the MVFS to
be case-preserving or if you want to use snapshot views on those projects, you must
manually rename the elements in the VOB that correspond to Visual C++ project file
names to have the case-correct names. For example:

cleartool checkout .
cleartool mv foobar FooBar
cleartool mv
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...

...
cleartool checkin .

New projects created in a snapshot view or in a case-preserving MVFS environment
require no such renaming to work properly.

Using ClearCase with Microsoft Visual Basic

Use the following guidelines when using the ClearCase integration with Microsoft
Visual Basic.

Disabling the IDE During Project Debugging

The Visual Basic IDE by design disables or unloads all add-ins while debugging a
project. Therefore, the ClearCase toolbar, which is an add-in, is disabled; no ClearCase
operations can be performed from the Visual Basic IDE while the debugger is running.
ClearCase operations can be performed while debugging outside the Visual Basic
IDE by using ClearCase Explorer.

Problem Checking in Identical .frm Files in Visual Basic 6.0

By default, ClearCase does not create a new version of a file that is identical to its
immediate predecessor. When you attempt to check in a .frm file that is identical to
the checked-in version, the integration does not check it in. However, if the .frm file
has an associated .frx file, the integration checks in the .frx file and any other binary
files associated with the .fm file, and the files may become out of sync. To avoid this
problem, set the option to allow identical checkins.

FRX Files Kept in Sync with FRM Files

In previous releases, if a form and a matching .frx file were created in a directory other
than the one containing the project file, Visual Basic could not track the .frx file for
source control purposes. In this release, ClearCase searches for .frx files and performs
source control operations on them to match those done on the .frm file.

FRX File Not Checked Out When Part of Visual Basic Group

In a Visual Basic version 6.0 project that is part of a Visual Basic Group, when you
check out an .frm file (with an .frx file), ClearCase does not check out the associated
.frx file automatically. This behavior may cause synchronization problems. When
working with a Visual Basic 6.0 project that is part of a Visual Basic Group, be sure
to check out both the .frm and .frx files.
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Error Message When Opening Visual Basic 6.0 Project

When you open a Visual Basic 6.0 project that is checked in, the integration displays
the following error message:

Failed to update project location information in the host application

You see this message because the Visual Basic project file is not checked out and the
project location information cannot be updated. To avoid this message, check out the
project file before you open the project.

Reopening Visual Basic 6.0 Project Fails to Update Project
Information

When you use Visual Basic 6.0, a problem can occur if a project’s source files reside in
a dynamic view that is mapped to drive M. After you reload it, Visual Basic cannot
reopen the project from the list of recent projects at the bottom of the File menu and
displays the error message reopening recent project fails to update project

information in recent project.

To work around this problem, you can delete the file MSSCCPRJ.SCC, which Microsoft
creates, and then add the project to source control again.

Using ClearCase with Microsoft Word

Follow the guidelines below when using the Version 2002.05.00 integration with
Microsoft Word.

Removing the Old Integration if Two ClearCase Menus Appear

If two ClearCase menus appear at Word startup, this means that the old integration
with Word 97 was not successfully removed even though the user is running Word
2000. This may occur if the location of the startup folder has changed, thus moving
the clearcase.dot template from its default location. The clearcase.dot template will
need to be deleted manually. To remove the old integration, locate the clearcase.dot file
in the Word startup directory.

1 In Word, click Tools > Options.

2 In the Options dialog box, click the File Locations tab.

3 Double-click the Startup item to open the Modify Location dialog box.

4 Right-click in the large list box in the center of the dialog box (the list box may be
empty) to display the shortcut menu. Click Explore to start Windows Explorer. In
Word 2000, the startup folder is displayed in the Folder name box in the dialog box.

Windows Explorer is rooted in the Word startup folder.
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To remove the old integration, remove the .dot file associated with it from your Word
startup directory, or rename the file to have a different extension.

Word Does Not Recognize a File as Versioned if it Is Opened with
the DOS "short name"

A file opened with a pathname like T:\ABISSO~1\test.doc will appear to be a
nonversioned file.

ClearCase Does Not Recognize a Versioned file if a URL Is Used
as a Pathname

If the pathname to the document that is being edited is a URL the integration does
not treat the file as an element even if it is. The integration behaves as if the file is
not in a VOB directory.

ClearCase Operations Do Not Work When Word Is Embedded
Within Internet Explorer

When a Word document is displayed within Internet Explorer the pathname that is
made known to the Word integration is not useful. Therefore, it is not possible to
handle a document as a ClearCase element when editing with Word embedded in
Internet Explorer. Note also that, in this case, all ClearCase commands are enabled
and none work correctly.

Under Certain Conditions, ClearCase Menus Are Disabled

All menu items are disabled if either one of two conditions exists: no document is
open or the Connected to network for ClearCase operations check box is not selected
in the ClearCase control panel applet on the Options page. This is by design. This
switch is intended to be used by applets to disable operations that would otherwise
hang the system until a time-out occurred.

Problems Working with Files Opened in Word

In general, if you rename or delete an eclipsed file, the operation is performed only on
the view-private object that is eclipsing the ClearCase element.

The exception occurs when the view-private file is being edited in Microsoft Word.
Word maintains a lock on the file, which makes it impossible for any other program to
touch or operate on it.

Workaround: Close the file in Word, or use the ClearCase integration with Word.
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Word XP Launches Two Windows for Diff and Merge

When the Microsoft Word integration is used with Word XP, the diff and merge
functions work differently from earlier versions of Word.

When doing a comparison, two windows appear. The top-most window contains the
comparison results. Closing that window results in a prompt to save a temporary
document. You can safely answer No. You will then have to close the window that
was behind the comparison window.

When doing a merge, two windows appear as well. The top-most window contains
the merge results. After resolving merge choices, closing that window results in
the expected prompt to save the merge results. Once accepted, another prompt is
displayed to save a temporary document. You can safely answer No to that prompt.

Using ClearCase with Sybase PowerBuilder

Using the ClearCase integration with PowerBuilder requires some configuration steps.
In addition, there are some differences between the integration with PowerBuilder 6.x
and PowerBuilder 7.x.

Applying Patches to PowerBuilder 7.x

Before using the ClearCase integration with PowerBuilder 7.0 to
7.02, apply the latest PowerBuilder patch available for the file PB-

SCC70.DLL. You can download this patch from the Sybase FTP site at
ftp://psaftp.sybase.com/pub/private/pbpatch/pb701.weekly/202861.zip. This patch is not
needed for PowerBuilder versions later than 7.02.

Enhancing the ClearCase-PowerBuilder Integration

Use the following procedure to add a Help button to the ClearCase integration with
PowerBuilder. After the integration is configured, PowerBuilder displays an icon on
its toolbar for ClearCase Help.

1 Start PowerBuilder

2 Right-click the Powerbar (where the icons are located); on the menu, click
Customize.

3 Select your icon by clicking the Custom option.

4 Select an icon, drag it to the Powerbar, and position it as desired relative to the
other icons on the bar.

5 To separate the ClearCase Help button from others on the Powerbar, use one or
more separator icons (located in the left corner of the set of possible icons).
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6 After the new icon is positioned, you are prompted to enter the command line to
be associated with the icon, as well as text to represent the icon in the Microhelp
and when the cursor is positioned over the icon. Set the command line to the
value winhlp32.exe ccase-home-dir\bin\ph_int.hlp. Set the values of the Item Text and
Item Microhelp boxes to ClearCase Help.

7 Click OK to finish the configuration.

ClearCase Integration Differences: Version 6.x and 7.x

New PowerBuilder 7.x functionality is reflected in the following differences between
the ClearCase integrations with PowerBuilder 6.x and with 7.x.

� In 7.x, the Source menu includes the command Add Objects.

� In 7.x, the Source menu does not include a Create New Release command; that
functionality is provided by Library > Create.

� In 7.x, if your VOB is set up for UCM development, when you click Source >
Configuration to open the Configuration dialog box, and then click Advanced,
ClearCase displays an Activity option.

Error5 Message When Using PowerBuilder Integration

If you select an object from the public directory and click Source > Register, the
integration opens a dialog box where you enter the name of the .PBL library. If the
library you specify does not exist in the archive directory, the integration creates
a new one and adds it to source control in the archive directory. If you attempt to
check out the same object from the public directory by clicking Source > Check Out
specifying a different name, the integration fails with an error5 message. To work
around this problem, be sure to enter the exact name of the target .PBL when you
check out an object.

Error Opening config_spec During View Startup

At view startup, more than one process may need to access the view’s configuration
files. Prior to Release 4.2, the sharing mode used to open these files was too restrictive,
resulting in occasional failures when trying to access these files. At this version of
ClearCase, the sharing mode allows all processes to be granted the access they require.

Problems When Administrative VOBs Are Unavailable

An administrative VOB is used by one or more other VOBs as a central repository
of global type objects. For a description of this feature, see the Administrator’s Guide
for Rational ClearCase.
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ClearCase users may see errors when the administrative VOB is unavailable.
Following are examples of situations when this may happen:

� A user attempts to attach a version label, using a label type that was previously
created automatically, as a local copy of a global label type. The ClearCase mklabel
command tries to contact the administrative VOB that contains the global label
type. If that administrative VOB is unavailable, the mklabel command fails.

� A VOB backup script attempts to lock the entire VOB object of \proj before copying
data to tape. For each administrative VOB used by \proj, the ClearCase lock
command tries to contact the administrative VOB. If any administrative VOB is
unavailable, the lock command fails, which causes the backup script to fail.

To disable the above checking for a particular ClearCase command (for example, to
keep working while an administrative VOB is offline):

1 Log on as administrator.

2 Set the environment variable CG_PROCFLAGS to the value no_process.

a Open the System Control Panel.

b Click the Environment tab.

c Set the user variable CG_PROCFLAGS to the value no_process.

3 Execute the command.

Restrictions on Use of VOB Schema 53 with Domain Trust Lists

This note applies only to VOBs using the VOB schema 53, not to VOBs formatted
using the schema (54) provided originally with Release 4.0.

You can change the contents of a domain’s trust list with the User Manager for
Domains, but the contents of a domain’s trust list rarely change. Because of the way
ClearCase implements security, removing domains from a domain’s trust list can
invalidate ClearCase security information. Restoring a removed domain to a trust list
does not fix ClearCase’s security data.

More specifically, if the domain you remove from a trust list contains ClearCase user
accounts or computers that use ClearCase, then ClearCase protection errors may
result. Symptoms of these errors are as follows:

� Certain operations, such as checkout, may fail.

� ClearCase may print numeric values when you expect user names.

To display user and group information, use the creds command.
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Because of these potential problems, we recommend that you avoid removing
domains from a domain’s trust list. If a domain is removed from a trust list, contact
Rational Technical Support for information on how to correct ClearCase’s security
information.

Restrictions on Use of VOB Schema 54

There are a number of restrictions on the use of the larger VOBs created using the
extended VOB functionality (VOB schema 54):

� reformatvob –rm may not completely remove an old VOB database directory
during the load phase of the reformat operation. If the reformat cannot be
completed because there is not enough disk space on the host, remove the
old VOB database directory manually. This directory has a name of the form
VOB-storage-directory\db.reformat. After you remove this directory, run reformatvob
–load.

� reformatvob uses the space command to calculate the amount of space needed for
a reformatting operation. This fails for large database files, although the failure
does not cause the reformat itself to fail.

� The space command cannot successfully run the stat() routine on large database
files. As a result, the cleartool space –vob –generate command can fail. This, in
turn, can cause the Standard ClearCase Daily Tasks task, supported as part of new
administration functionality in Release 4.0, to fail. If you have a VOB with large
database files, the space command fails nightly on scheduled jobs.

To avoid this problem, edit the scheduled job list so that it runs only on VOBs that
do not have large database files. You can do this by modifying the Daily Vob
Space task on the MMC console Properties sheet.

Do Not Change VOB/View Storage Directory ACLs on NTFS
File Systems

On NTFS partitions, each ClearCase VOB or view storage directory has an access
control list (ACL). Modifying the ACL in any way can render the VOB or view
unusable.

Because the standard Windows NT file-copying tools (and some backup utilities) do
not preserve file and directory ACLs, use the procedures in the Administrator’s Guide
to copy, move, or restore a VOB or view storage directory.
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Restart After Changing ClearCase Registry Server

Some ClearCase operations may not work correctly after you change your default
registry server. Some symptoms include ClearCase shortcut menus that do not
appear correctly or source control operations that fail in Microsoft Visual Studio.
We recommend that you shut down and restart your computer after changing the
registry server.

Creating VOBs and Views on Windows 2000 Hosts

On Windows 2000 hosts, VOBs and dynamic views must be created with the storage
directory on a partition that has a drive letter assigned. If the VOB or view storage is
on a Windows 2000 mounted drive, local clients cannot access the VOB or view.

DDTS Integration Uses Wrong Environment Variable

The DDTS trigger scripts use the CLEARCASE_PNAME environment variable, but this
environment variable is not set. Instead, the CLEARCASE_PN environment variable is
set to the correct value.

The workaround is to set CLEARCASE_PNAME to CLEARCASE_PN at the beginning of
each trigger that uses the environment variable.

Misleading Licensing Error Message

If you do not assign a ClearCase LT server for your client and you try to run any
ClearCase LT tool that contacts the server, the error message you get is the same as if
you had no license. If you get an error that tells you that you do not have a license for
the product, but you are certain that you have a valid license, make sure you have a
server name entered for the client. Click Start > Settings > Control Panel and click the
ClearCase icon. Verify that a valid ClearCase LT server host name is in the edit field.

reformatview May Fail Under Certain Conditions

On Windows systems, automatic view reformatting may be unable to move the view’s
database directory, db, to an alternate name during the dump phase if the file is open
or if a process has a current working directory there. The view server will retry the
rename operation two times at 60 second intervals to allow any processes to close the
directory or set working directory elsewhere. In case the retries fail, ensure there are
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no open files in the view’s database directory and attempt to access the view again. It
should reformat cleanly. All of these operations are logged in the view log.

Documentation Issues

This section presents late changes to documentation and describes errors or
information missing from the documentation delivered with ClearCase software.

Problem with Reference Pages

The following problem relevant to ClearCase exists in the Command Reference.

mount

On Windows NT, mounting VOBs with the read-only option (ro) has no effect.

rebase

With the introduction of stream hierarchies at this release, most of the rules for
rebasing an integration stream and a development stream are now the same. The
rebase reference page contains sections on Rules for Development Streams and Rules
for Integration Streams. These sections are superseded by information in the section
Rebasing a Stream on page 42 in this version of the release notes.

Problem with Developing Software Documentation

The Developing Software documentation is missing information relating to the
following topics.

Cannot Run ClearCase Commands in a UNIX Snapshot View from
a Windows Client

You can access a snapshot view that was created on a UNIX host from a ClearCase
client on Windows, but you cannot run ClearCase commands from that Windows
client and have them be effective in the UNIX snapshot view. For example, if you use
Windows Explorer to navigate to a team member’s view on a different computer and
right-click a file in the view, ClearCase options may not be available. To perform
ClearCase operations on the files in a team member’s view, register the view as
follows:

1 In Windows Explorer, navigate to the root directory of the view you want to
register.

2 Right-click the root directory of the view.
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When you right-click the root directory of the view, ClearCase registers the view by
adding an entry to your Windows User Profile.

Delivering Work to a Snapshot View

If you deliver your work to a snapshot view, you can encounter an error caused by
your not having ever registered the snapshot view. This condition occurs because
ClearCase cannot find the path to the snapshot view root directory until you register
the view. Typically a view is registered when you run the mkview command.

On Windows computers, you see the following messages:

The deliver operation is unable to access the root of the

’%s’ snapshot view.

(Before trying again, make sure that you can access

ClearCase properties by right-clicking on the view’s root

directory in the Windows explorer.)

Performing the recommended action registers the snapshot view so that the deliver
can proceed.

Handling Elements That Are Not Visible

(The following material should be used as part of Section 5.4, Merging Versions in
Part 2, Working in UCM.)

During a deliver (or rebase) operation, you can see the following warning message
about elements not being visible in the integration view:

1 elements were skipped because they are not visible. You should

determine why they are not visible before you complete this deliver

or rebase operation. If these elements should be visible, cancel

this operation, fix the problem, and re-run the operation.

Do not ignore this situation. The deliver operation found versions of elements in the
development stream that need to be considered for merging to the target stream, but
did not find the elements in the target stream. Possible causes for this situation:

� A new element was added to source control, but the directory that catalogs the
element is not checked in.

In this case, cancel the deliver or rebase operation, check in the directory, and
start deliver or rebase again.

� While a change to the element was being made (in the development stream, for
a deliver; in the stream from which you are rebasing, for a rebase), someone
operated on the element (in the target stream, for a deliver; in the development
stream, for a rebase), as follows:
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� The name of the element or the name of a VOB symbolic link to the element
was removed.

� The element itself or the VOB symbolic link to the element was removed.

In either case, decide whether the removal was appropriate. If the removal was
appropriate, you can allow the deliver or rebase to ignore the element.

� The change may be obsolete, because you intended to remove the name of the
element or the element itself.

Because ClearCase cannot tell what caused the situation, you must find the cause, fix
the problem, cancel the current operation, and start over.

Problems with Online Help

The following issues exist with online help.

Topic Not Found

If you start help by pressing F1 in an application window (context-sensitive help) and
begin a series of jumps into the online documentation, you may see the error help
topic not found, when in fact the topic exists. If you click OK in the error message
box, the topic then appears.

PowerBuilder Integration Help

In the Configuring the PowerBuilder/ClearCase integration for UCM use (new PBLs)
module of the PowerBuilder Integration Help, the perl command in step 2b should
read

ccperl ccase-home-dir/bin/ccpb_ucm_config.pl

Help Window Is Blank

Occasionally, a ClearCase help topic fails to appear: the title appears, but the body of
the window is blank. When this happens, you can correct the problem as follows:

1 In the Help window menu bar, click Options > Font > Normal. The Help window
is refreshed.

2 If the wrong help topic is displayed when the Help window is refreshed, click the
Back button to return to the original topic.

Issues with Tutorials

This section describes problems with running tutorials.
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Problems with Line Endings in Makefiles

The Base ClearCase Dynamic Views tutorial uses scripts that create a tutorial
environment and populate it with files that allow the user to learn in an interactive
manner how to work with ClearCase. One of these files is a file called Makefile,
which is used when the user is instructed to build the tutorial application. When each
line of this file ends in ^M it prevents the user from building the tutorial application.
To resolve this issue, check out the Makefile, remove the ^M characters at the end of
each line, and then check the file back in.

Project Leader Tutorial Setup Fails if No Shares Present

When setting up ClearCase on systems running Windows NT/98/2000/XP, it is
necessary to set up a tutorial share on the system of each user who will run the
ClearCase tutorials. The permissions for this tutorial share should be as follows:
� Everyone: Read
� the tutorial user: Full control

Tutorials in the Windows Environment

Before users run the tutorials, the administrator must set the correct view and VOB
storage needed to run the Windows NT or Windows 2000 tutorials. Users can verify
that this was done by entering the following cleartool lsstorage commands and
checking the output:

cleartool lsstorage –view

cleartool lsstorage –vob

If each command does not display a list of views or VOB storage locations, the tutorial
will not run.

Tutorial Setup Script Fails on Windows XP

In Task #6 of the ClearCase UCM Project Manager tutorial, a setup script prepares the
tutorial environment to allow the user to create a new baseline. When executing the
setup on a system running Microsoft XP, the setup script fails to execute correctly.

The workaround is to set the COPYCMD environment variable with a value of /Y as
follows:

1 Open Control Panel and click the System icon.

2 Click the Advanced tab and then click Environment Variables

3 Under User variables click New.

4 As Variable Name, enter COPYCMD
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5 As Variable Value, enter /Y

6 Click OK to close the New User Variable dialog box, the Environment Variables
dialog box, and then the System Properties dialog box.

You can then resume the tutorial.

Incorrect Steps in Project Manager Track of ClearCase LT Tutorial

In the unit titled Set up and create the ClassicsWeb project in the Project Manager
Track of the ClearCase LT Tutorial, steps 3 and 4 in the Create an integration view
topic are incorrect. They should say:

3. At the step, Choose location for a snapshot view, click Finish to accept the default
view storage location. Click OK at the Confirm screen.

4. The Choose Element to Load screen appears. Select ClearCase Tutorial from the
Available Elements list and click Add. Click OK to confirm your choices. After the
elements are loaded, click OK at the View Creation Status message box.

Start Menu Differences

In the ClearCase LT printed and online documentation, the names of programs differ
from the names that you see on the Start menu. For example, the ClearCase LT Doctor
help file says:

To start ClearCase Doctor, click Start > Programs >
Rational ClearCase LT > ClearCase Doctor .
Note: if ClearCase LT was installed as part of a Rational Suite, the Rational ClearCase
LT entry appears below the name of the suite.

The text should show the proper name of the program as Rational ClearCase LT Doctor.
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Status of ClearCase
LT Software Change
Requests

6

Noteworthy problems found in or resolved in Version 2002.05.00 of Rational
ClearCase LT are listed in the file cc_issues.htm.

You can find this file in the folder ccase-home-dir\install\ after you’ve installed the
product.

Note that any problems relating to installation or setup of ClearCase are noted in
the section Installation Issues on page 29.
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Contacting Rational
Technical Support 7

If you have any problems with the software or documentation, please contact Rational
Technical Support by telephone, fax, or electronic mail as described below.

For information regarding support hours, languages spoken, or other support
information, click the Technical Support link on the Rational Web site at
www.rational.com.

Your location Telephone Facsimile Electronic mail

North
America

800-433-5444
toll free or
408-863-4000
Cupertino, CA

408-863-4194
Cupertino, CA
781-676-2460
Lexington, MA

support@rational.com

Europe,
Middle East,
and Africa

+31-(0)20-4546-200
Netherlands

+31-(0)20-4546-201
Netherlands

support@europe.rational.com

Asia Pacific 61-2-9419-0111
Australia

61-2-9419-0123
Australia

support@apac.rational.com
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